Presenting in 3D

- Wizards • Map production • 3D presentations • Annotation • Orthophoto • Surface gridding • Contouring
- Image mosaicing • Data compression • Geocoding • Spatial analysis • Raster to vector
- Land use classification • Data integration • Image analysis • Radar processing • Fast Fourier Transforms

Add 3D realism to your work
See the world as it is. Save time and increase effectiveness by getting instant 3D visualization of your area of interest.

Include 3D on your standard PC desktop
Unlock high powered 3D imaging—perspective, flythrough and surfaces

Drape vectors over 3D maps
Combine all your data—vector and raster—in one 3D image.

Print top quality 3D maps
Get high resolution 3D output at any size with breakthrough software technology.
1. Understand data better, in 3D
There is just no comparison between a normal image and a 3D render. The third dimension brings immediate understanding that no amount of visualizing of contour lines can give. You can use 3D to:

- Highlight fine attributes or data errors that can’t be seen in 2D
- View your data from any angle to get a complete picture
- Add 3D understanding to give power to presentations

“ER Mapper 3D is a paradigm shift in image interpretation methodology.”
-- David Pratt, Encom

Color orthophoto mosaic draped on high resolution DEM

ER Mapper #1 for 3D functionality
✔ Easy to use wizard interface
✔ Flip easily between normal and 3D views
✔ Enhance images in 2D or 3D
✔ No new disk files for 3D viewing
✔ Adjustable on-screen resolution and rendering options for optimal speed
✔ Mouse controls for manipulating 3D models
✔ Adjustable surface illumination and surface transparency
✔ Fog and shininess effects
✔ Read ground coordinates using a 3D cursor

2. View in 3D on your PC
With ER Mapper you get powerful 3D functionality on your desktop PC:

- 3D perspective—view your area from different points
- 3D flythrough—take the pilot seat and explore your data up close
- Multiple 3D surfaces—correlate all your data for comparison

Color orthophoto mosaic draped on high resolution DEM

ER Mapper #1 for 3D applications
✔ Identify line-of-sight issues before going into the field, saving time and money
✔ Model risk for natural disaster planning
✔ Combine different data in different surfaces to study change
✔ Combine all your planning data in 3D to make your decisions easier and more effective
✔ Quickly see poor data or gridding errors that aren’t apparent in 2D
3D to the desktop

3. View vectors and images in 3D
With ER Mapper you can process all of your data in 3D. Gather information and data from any number of sources. Incorporate raster imagery with true 3D vectors (including the latest data from your GIS) and display the results in 3D.

“ER Mapper possesses incredibly powerful and easy-to-use tools for interactive map creation and editing.”
-- PE & RS magazine, March 1996

4. Generate stunning 3D output
3D image processing is worthless if you can’t print that impressive 3D view. ER Mapper provides high quality 3D output—whether you need printed maps or graphics files. Unlike other 3D software, ER Mapper uses an internal OpenGL engine to create the highest quality 3D output your printer can deliver. You get results that look like a photo rather than a stack of data!

ER Mapper #1 for multiple 3D surfaces
- Compare data in different surfaces
- Combine RGB, HSI and pseudocolor imagery and data attributes
- Vary transparency and distance between layers for an optimum view
- Investigate areas of interest from any angle

5. Try for yourself
Evaluate ER Mapper with the free CD-ROM which contains:
- The complete ER Mapper software
- 14 day evaluation licence
- Online manuals
- Over 400Mb of sample data

Industry leaders using ER Mapper include:
Encom Technology routinely uses ER Mapper for its international mineral and petroleum exploration projects. Its 3D capabilities have greatly improved our ability to understand datasets in areas of significant topographic relief. A recent project for base metal exploration in Northern Africa integrated Landsat TM and SPOT satellite data with aeromagnetic and electromagnetic geophysical survey images.

With the terrain relief of some 3000 metres, the project area presented some special problems. The Landsat data was acquired at 6:48 a.m., and as a result much of the scene has extensive shadows cast from the high mountain terrain. This is excellent for mapping structures with surface expression, but the shadows dominate any contrasts that could be associated with changes in rock type or alteration associated with mineralisation events.

Evidence of the terrain shadows is easily seen in the RGB (741) image.

Minimisation of the shadow effect can be achieved by ratioing different image bands on the assumption that each wavelength band is equally affected in the shadow zone. This assumes that the diffuse reflection characteristics of the ground surface is similar on the illuminated and shadow side of the terrain. Atmospheric back scatter must also be removed from the TM channels prior to ratioing.

A modification of the Abrams ratio was used to highlight spectral contrast, with RGB channels mapped to 3/2, 5/7 and 4/3. The 3/2 ratio enhances iron oxide content, while the 5/7 ratio is small in the presence of abundant iron and large in the presence of abundant clay. The 4/3 ratio highlights vegetation in green. We applied a light 3 point gaussian filter to minimise the noisy characteristics of the 3/2 ratio.

The effectiveness of the shadow elimination procedure is evident in the Abrams image.

This image highlights a major unconformity with Cretaceous rocks (yellow) over Proterozoic basement (blue-red).

Although the Landsat scene indicates dramatic terrain relief in the project area it was difficult to assess the relative relief across the scene. We decided that visualisation of this relationship would be much easier in 3D with the Abrams ratio image displayed over terrain.

SPOT stereo would be ideal for building a high quality digital terrain model but for preliminary evaluation we used data downloaded from the EROS data centre at the USGS. This data had a 1 km resolution, so we regridded it to provide a cell size of 100 metres. This produced a smoothly varying terrain image that did not add artifacts into the 3D presentation.

ER Mapper 5.5 was then used to incorporate the modified Abrams ratio image with the USGS elevation data as a height layer to produce a 3D perspective view, where it could be rotated and tilted in real time. This allowed us to zoom into particular areas and concentrate on delineating the geological units.
Case study — Virtual reality highway design

Application by UK Highway Agency, UK

Highway design, planning, and construction is a costly process. With today’s ever increasing requirements for public consultation, the planning and approval process constitutes a large proportion of project costs. Currently, the tools used for presenting proposals are quite separate from those used for design. Putting information into a format suitable for public comment is costly, resulting in a lesser breadth and depth of information being made available to interested parties, with no easy way to generate additional requested views.

A research project, spearheaded by the UK Highways Agency, is attempting to use virtual reality technology to develop an improved process for planning routes, consulting the public and designing roads. The research team, comprising ACT at the University of Reading, WS Atkins Consultants Ltd, and Taylor Woodrow Management Ltd, was given the task of taking an existing scheme through a new process, challenging technology to provide the required information.

A recently constructed project, designed by one of the project partners, was selected. Initial data came from the UK Ordnance Survey and comprised 1:50,000 colour raster maps, 1:10,000 mono raster maps, 1:2,500 colour vector data and raster digital terrain data. This was supplemented by colour raster images supplied by other organisations. In addition, as-built detailed survey data and design data was available for the as-built scheme, as well as pre-construction photographs, early route options and environmental information around the region.

The research team used digital imaging tools to combine the various datasets to visually inspect the area in 2D and 3D and so identify potential route alignments. The tools also enabled geocorrection of unprocessed data in order to ensure all datasets were correctly referenced to the UK National grid. When data, such as environmental constraints, was only available as hardcopy, the digital imaging tools made it possible to digitise regions over a georeferenced dataset to create a new vector layer representing the environmental constraint. This effectively enabled the highway planner to create new datasets of any relevant constraint.

Potential route corridors were identified and then digitised and exported as georeferenced vectors. This route vector was subsequently imported into MacRoad, a highway design tool, and engineered into a full highway design.

The highway design tools enabled the designer to access the same digital terrain models as well as vector layers showing natural and artificial features as are used in the route identification process. Consequently, the designer could ensure that the fully designed highway would not interfere with any features specifically identified earlier. MacRoad provided great flexibility by enabling the horizontal alignment, cross-section and vertical profile to be varied with automatic on-screen updating of the design and material quantities. Once a highway had been successfully created it was exported along with a newly re-triangulated digital terrain model.

The exported highway design and terrain model could either be further developed into a virtual reality model or be re-imported into the digital imaging software and be viewed once more with raster data. The latter approach enabled rapid evaluation of expected land take and visual intrusion.

The project team found ER Mapper particularly useful for presenting the images and data in a PC format that was readily accessed by the public. The data could be explored in 3D giving them instant answers to questions about positioning and impact. In addition, they could select from the available datasets at will. The printed output both of 2D and 3D views provided a useful medium for supplementing displays at public consultation events.

The study is ongoing, with results to date proving very optimistic; the increased information and the expected savings in time and effort will result in considerable monetary savings and a hoped-for improvement in public relations, leading to the design and construction of better highways.
Getting started with ER Mapper

Here are a few tips to get you started visualizing and integrating images in 3D.

These examples use sample data that is installed with the “Typical” ER Mapper installation option.

If you have not received a CD-ROM please contact your reseller.

Creating a 3D algorithm

1. Add the Wizard toolbar by selecting it from the Toolbars menu.

Moving in 3D Perspective

In 3D Perspective view you manipulate the image as though it is an object in space. Thus, you move the image up and down while you remain in the same place. Try moving the image using the following:

- **Rotate round Y axis**
  - Left mouse button—drag left or right

- **Rotate round X axis**
  - Left mouse button—drag up or down

- **Rotate round Z axis**
  - Left mouse button and plus the right mouse button (hold both down)—drag up or down

- **Zoom in (out)**
  - Right mouse button—drag down (up) screen

- **Move**
  - Right mouse button plus the left mouse button (hold both down)—drag

Adding an additional surface

1. Click the View Algorithm for Image Window button.

2. From the Wizard toolbar select the 3D Algorithm Wizard button.

3. Select the type of 3D algorithm you want to produce. In this case select RGB(321) and click next.

4. For the Raster image select from your ER Mapper installation area, the ‘examples\Shared_Data’ directory and the ‘Landsat_TM_year1985.ers’.

5. For the Height Dataset select the ‘examples\Shared_Data’ directory and the ‘Digital_Terrain_Model_20m.ers’ dataset.

4. Click Finish.

An RGB 3D image is displayed.

2. In the Algorithm dialog, click the Add a new surface button.

3. Click on the new surface to select it.

4. On the Layer tab click the Load Dataset button and select
the ‘examples\Shared_Data’ directory and the ‘SPOT_Pan.ers’ dataset.

5. Select the Height layer from the original surface and copy and paste this layer into the new surface.

6. Select the Surface tab and change the Color Table to greyscale. The image is redrawn with the second surface.

By Selecting the Surface tab on the Algorithm dialog you can adjust the Z Scale, Z Offset and Transparency of each surface.

You can also adjust how the image is rendered. From the 3D View tab select different options from the Draw Mode drop down menu.

**Flythrough your 3D image**

From the Algorithm dialog change the View Mode to 3D Flythrough.

When you move around the image in 3D Flythrough it’s as though the ground is stationary and you move around it, exploring the landscape. Thus, features will appear to move in the opposite direction of your motion. Try moving around the image using the following:

- **Move up (down)**
  - Hold down the left mouse button in top (bottom) half of image

- **Move left (right)**
  - Hold down the left mouse button in left (right) half of image window

- **Change altitude**
  - Right mouse button—drag down (up) screen

**Reading the cell coordinates using the 3D cursor**

1. Open the Cell Coordinates dialog from the View menu.

2. From the Standard toolbar select the Set Pointer Mode button.

3. Position your cursor in the image window, then press and hold down the left mouse button. As you move the cursor ER Mapper displays the cell coordinates.

**Adding annotation to your image**

1. From the Algorithm dialog select Edit and then Add Vector Layer and Annotation/Map Composition.

2. On the Layer tab click the Load Dataset button.

3. From the ‘examples\Shared_Data’ directory select ‘San_Diego_roads.erv’.

You can continue to do image enhancement, such as sun-shading, while annotating.

**Other examples**

These examples showed you how to use toolbar buttons and supplied algorithm views to visualise your geophysical data. To get some more ideas for using ER Mapper try loading the algorithms in the following directories from your ER Mapper installation area:

- ‘examples\Functions_And_Features\3D’
- ‘examples\Functions_And_Features\3D_multi_surface’

**Going on from here**

Explore the other algorithms supplied with ER Mapper. Also, open the Algorithm window by clicking the View Algorithm for Image Window button and observe how the processing is represented as you view different algorithms. You may also use your own data. Read Chapter 3 Starting out with ER Mapper 6.0 in the User guide manual for an explanation of how ER Mapper works. Check out relevant chapters in the Tutorial manual for a more thorough walk through of examples.
ER Mapper 6.0
Helping people manage the earth

- Wizards • Map production • 3D presentations • Annotation • Orthophoto • Surface gridding • Contouring
  - Image mosaicing • Data compression • Geocoding • Spatial analysis • Raster to vector
- Land use classification • Data integration • Image analysis • Radar processing • Fast Fourier Transforms

New features include:
- ✔ Free imagery plugins for GIS systems
- ✔ Orthorectification of airphotos
- ✔ Image display and mosaic wizard
- ✔ The Image Balance wizard
- ✔ The Geocoding wizard
- ✔ The Surface Gridding wizard
- ✔ The Contouring wizard
- ✔ Save as... to popular formats
- ✔ File open... directly from popular formats
- ✔ Image compression wizard
- ✔ Real time roaming and zooming
- ✔ Radar processing fully bundled

ER Mapper is fully supported worldwide by 510 Reseller offices. Reseller enquiries welcome.

All brands, company names and product names are trademarks or registered trademarks of their respective holders. Not all functions are available on all platforms. Product specifications subject to change without notice.

Authorized Reseller

View ER Mapper images inside other software

View multi-surface 3D

View images and vectors in 3D

Oil and Gas exploration

Mineral exploration

Asia Pacific Region Office:
Earth Resource Mapping
Level 2
87 Colin Street
West Perth
Western Australia 6005
Telephone: +61 8 9388-2900
Facsimile: +61 8 9388-2901

European Region Office:
Earth Resource Mapping
Blenheim House
Crabtree Office Village
Eversley Way, Egham
Surrey, TW20 8RY, UK
Telephone: +44 1784 430-691
Facsimile: +44 1784 430-692

Americas Region Office:
Earth Resource Mapping
4370 La Jolla Village Drive
Suite 900
San Diego, CA 92122-1253, USA
Telephone: +1 619 558-4709
Facsimile: +1 619 558-2657

ER Mapper
Helping people manage the earth
www.ermapper.com